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Abstract
Michael J. Raymond

AN INVESTIGATION OF THE POTENTIAL FOR AND APPLICATION
OF LIFE CYCLE ANALYSIS IN THE PHARMACEUTICAL INDUSTRY
2009/12
Mariano J. Savelski, Ph.D. and C. Stewart Slater, Ph.D.
Master of Science in Chemical Engineering
Life cycle assessment offers a unique opportunity to analyze emission reductions
across all manufacturing sectors. However, few efforts have been made to apply this
method to the pharmaceutical industry. The Toxic Release Inventory is a powerful tool to
determine areas of high potential for emissions reductions in industry. When applied to
the pharmaceutical industry and coupled with a life cycle assessment, areas for
significant environmental improvement become apparent. By examining these trends and
exploring a variety of emissions reductions techniques, life cycle emissions in these
problem areas may be significantly reduced. These trends demonstrate that manufacture
of virgin solvent and solvent waste management contribute significantly more life cycle
emissions than comparable processes for commodity chemicals, with the majority of this
waste consisting of CO2 and other green house gas emissions. Typically, between 80 and
90% of the total mass used in the production of an active pharmaceutical ingredient (API)
may be attributed to solvent use. Four case studies from Pfizer, Bristol-Myers Squibb,
and Novartis are examined. In these cases, solvent recovery and reduction techniques are
integrated into API syntheses. It is shown that the actual extent of the environmental
footprint reduction can only be realized with a full life cycle analysis.
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Chapter 1
Chapter 1: Introduction to Life Cycle Analysis and the TRI
Introduction to Life Cycle Analysis and the TRI
1.1. The TRI and its Application
Environmental consciousness within the United States has increased significantly in the
last few decades. A series of nine key environmental statutes were enacted between 1970
and 1990. Among these was the Emergency Planning and Community Right-to-Know
Act of 1986. This allotted for two main provisions; states must create local emergency
units that must develop plans to respond to chemical release emergencies, and the EPA
must compile an inventory of toxic chemical releases from manufacturing facilities. This
database of chemical releases is known as the Toxic Release Inventory (TRI). 1
The TRI provides a means for the public to access information regarding the number of
manufacturing plants in an area that release toxic chemicals, the sector of industry to
which those plants belong, the types of chemicals released, and the amounts of those
chemicals released. The TRI is updated annually, providing a useful tool in determining
trends in the control, use, and release of toxic chemicals.
The EPA uses the TRI in a wide variety of other programs, both for government and
public use. According to the EPA, the TRI:
“help[s] the public, government officials, and industry identify potential
concerns and gain a better understanding of potential risks, identify
priorities and opportunities to work with industry and government to
reduce toxic chemical disposal or other releases and potential risks
associated with them, and establish reduction targets and measure progress
towards reduction goals.2"
Before more detail is given on the uses and limitations of the TRI, it is important to
understand how the TRI collects data. One main category exists that groups all of the data
collected by the TRI, the “Total Production Related Waste.” This is then split into two
1

categories, “On-Site Transfers” and “Off-Site Transfers.” Each of these two categories is
further split into two subcategories, “Disposal or Other Releases” and “Other Waste
Management.” Table 1 and Figure 1 display the different categories into which TRI data
is grouped.

Table 1. Total Production Related Waste. (Note: POTW = Publicly Owned Treatment
Works)2
On-Site
Disposal or
Other Waste
Other Releases Management
Surface Water
Air
Land
Underground Injection
Recycling
Energy Recovery
Treatment
POTWs – Metals
POTWs – Non-Metals

2

Off-Site
Disposal or
Other Waste
Other Releases Management

Figure 1. Diagram of the Information Collected Under the TRI. 2

Upon understanding how the data is organized and collected, a few key points must be
noted. The two foremost of which involve exposure to TRI chemicals. It is crucial to
understand that the data provided by the TRI does not signify the toxicity of the
chemicals listed. Each of the chemicals that are regulated under the TRI is deemed toxic
to some extent; however the degree of toxicity may vary significantly between different
TRI chemicals. In addition, the potential of exposure relies heavily on the persistence of
the chemical being considered. Thus, the TRI does not display the harm of individual
chemical releases, neither absolutely nor in relation to one another, rather it only
quantifies the extent of the release.
Despite the aforementioned limitations, the TRI provides a powerful tool to identify
opportunities within an industry or specific manufacturing facility to decrease
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environmentally unfavorable practices. Although the TRI does not quantify waste from
non-toxic sources, it highlights the waste sources that are most harmful to employees, the
community, and the environment. This allows companies and private researchers to aim
towards reducing the most detrimental wastes. It also aids in bringing attention to
common practices that can be improved on a broader industry wide scale. The focus of
this chapter will be on the use of TRI data for these means, specifically within the
pharmaceutical industry. In addition, an in depth description of what defines a TRI
chemical, those chemicals that are included in the TRI, and how the definition of these
chemicals has developed over time is provided in the TRI Historical Changes section.
1.2. Introduction to TRI Use in the Pharmaceutical Industry
Small volume batches are common within the pharmaceutical industry. As a result, it is
considered environmentally unfeasible to recover wastes from these batches. 80-90% of
the mass that goes into producing an API is made up of solvents.3 By implementing a
small scale solvent recovery system, emissions may be reduced by over 90%. This will be
discussed throughout the proceeding chapters.
To improve the environmental efficiency of a solvent recovery technique, it is important
to understand both the main solvents of interest and additional opportunities for solvent
recovery from other processes at the facility to maximize usage of the equipment. In
addition, it is important to understand the environmental implications of recovering a TRI
chemical rather than a non-toxic or environmentally benign chemical. Although there are
still emissions associated with production, usage, and disposal of non-toxic and
environmentally benign solvent waste, recovery and reduction of TRI solvents provides
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not only a reduction in overall emissions, but the added benefit of reduction in the risks to
workers, the community, and the environment associated with the process.
For this reason, the TRI provides a powerful tool for determining the most beneficial
solvents to recover. Systems may be designed for recovering solvents that pose the
greatest threat to the environment and community. In addition, these systems can be
designed to recover a series of specific solvents that exist or are likely to exist in a
pharmaceutical manufacturing facility.
Following is a tutorial for using TRI.NET. This tutorial is designed to provide an
individual with no experience using the TRI or TRI.NET an introduction to the program
and all of its capabilities, with a specific focus on the use of the program to determine
TRI trends in the pharmaceutical industry
1.3. TRI.NET Introduction and Tutorials4
1.3.1. Tutorial Overview
This tutorial has been written using the TRI.NET User’s Guide provided with the
program and available online at http://www.epa.gov/tri/tridotnet/guide.html. The user
guide provides further details of how to use the program as intended. Anyone who is
considering using TRI.NET for analyzing extensive Toxic Release Inventory data should
also read the user guide along with this tutorial. The majority of the pictures within this
tutorial have been taken from screenshots of the program. The program is written by the
United States Environmental Protection Agency. The intended use of TRI.NET is for
retrieving and analyzing data from the Toxic Release Inventory for all reporting industrial
sectors. It is also very useful in determining the toxic releases found in a specific area,
company, or industrial sector. Data are available for 1988 through 2008 and are made up

5

of the reported toxic release data from all reporting industrial sectors. The tutorial case
study presented is based upon the total toxic releases in the pharmaceutical sector.
1.3.2. TRI.NET Introduction
TRI.NET is a program that allows quick navigation through US EPA Toxic Release
Inventory (TRI) data. The Toxic Release Inventory is a publicly available EPA database
that contains information on toxic chemical releases and waste management activities
reported annually by certain industries as well as federally-operated facilities. TRI.NET
allows for efficient data acquisition from the TRI for years between 1988 and present.
The program may be used for a variety of applications, such as waste management,
public knowledge, as well as industrial and societal demographics.
1.3.2.1. Download and Installation
To access the TRI.NET program, there is a free download available at:
http://www.epa.gov/tri/tridotnet/installer.msi.
1. A dialog box will open asking if you would like to open this file. Select “Yes."
2. Select “Save File” to begin downloading the install file.
3. Once the download has completed, go to Start →My Documents→ Downloads.
4. Double-click on the install file to launch the set-up wizard.
5. Follow the steps shown in the set-up wizard.
6. When the wizard has finished, a desktop icon and start menu entry will be created
for TRI.NET.
7. To run TRI.NET, use either the desktop icon or start menu entry.
Alternatively,

one

may

use

the

following

http://www.epa.gov/tri/tridotnet/download.html.
6

link

to

download

TRI.NET:

Follow the link and follow the

instructions listed for “Option 2.” This will install the program onto your computer’s hard
drive. Option 1 allows for installation to a flash drive for portable use of the program and
will not be included in this tutorial.
1.3.2.2. Auto-Update
Before using the TRI.NET program, ensure that all downloaded files and data are up to
date. **DO NOT UPDATE IF YOU ARE UNDER A SHORT TIME
CONSTRAINT**
1. Run TRI.NET
2. Click on the “Check for Updates” icon or go to Help→Check for Updates…

3. If data and software are current, select “Ok” and begin working.
4. If data and software are not current, install all updates. As the data files can be
large, be patient. This may take an extensive period of time.
5. Once updates have been completed, you may begin working.

7

1.3.2.3. User Interface
The following figures display the options available on the TRI.NET user interface.

Open Query

New Query

Run Built
Query

Export to Excel

Save Query

Navigates to Query
Input Screen

Select Year of Data
to be Analyzed

1.3.3. Introductory Tutorial
This tutorial will introduce the user to the capabilities and features of TRI.NET. Basic
options and commands will be defined and demonstrated. The purpose of this tutorial is
to familiarize the user with TRI.NET. It is recommended that more advanced users
attempt the 1.3.4. Advanced Tutorial.
1. Open TRI.NET.
2. Click on “Build Query.”

8

The screen should resemble the above image.

3. To save the query, click on the save icon,

, or go to File→ Save Query As.

Save this query as “1.3.3. Introductory Tutorial.”
4. Select the year of interest for your study. For this tutorial, we will be analyzing
data from the 2008 Toxic Release Inventory. Go to Data: and click on the arrow
to bring down the drop down menu.

9

Since we will be analyzing data from 2008, click on “TRI 2008: PDR 2008.” For
data from 2007, for example, you would select “TRI 2007: PDR 2007.”
5. On the left side of the screen, there is a directory that can now be used to specify
how the data will be analyzed.

Three types of variables are listed.
a. Grouping Variables – specify how the DATA variables are to be
aggregated; specify what variables will be used to group the data in the
analysis.
i. Click on Grouping Variables. A list of options will appear to the
right of the screen. By checking these boxes, you can specify how
results are grouped. For example, if you checked the box next to
“State,” upon finishing the query, all of the data for releases in
New Jersey will be grouped as a single data point.
b. Data Variables – the variables to be aggregated and presented in the
output; the data that will be displayed as results.
i. Click on the “+” sign next to Data Variables to expand the list.
Five types of data variables appear. If you click on any of these
variables, a list of options similar to that described under Grouping
Variables will appear.
10

1. Counts – whole number “count” of a specified metric. For
example, if you choose “Facility Count,” your results will
be reported as the number of facilities in whichever
grouping variables you chose.
2. Releases – amount of on-site and off-site releases, releases
to air, water, and land, and releases due to fugitive
emissions and other forms of release
3. Waste Transfers – amount of waste transferred to specified
off-site facilities, such as recycling and energy recovery
facilities
4. Waste Quantities – amount of waste managed; this includes
all waste released on-site and off-site, production related
waste, energy recovery, waste recycled, waste treated, and
nonproduction related waste; includes all Releases (2) and
Waste Transfers (3)
5. Hazard – threat posed by a specific grouping variable.
Results are reported as Toxicity x Pounds; the Hazard value
comes from another publically available EPA program,
RSEI (Risk-Screening Environmental Indicators)
c. Filtering Variables – restrict the data that get aggregated and presented in
the results; specify what data will be included in the query
i. Click on the “+” sign next to filtering variables to expand the list.
Eight types of filtering variables appear. If you click on any of

11

these variables, a list of options similar to that described under
Grouping Variables and Data Variables will appear.
1. Chemical Group – lists types of chemicals, such as
Hazardous Air Pollutants (HAPs) and OSHA carcinogens.
For example, if you checked the box next to “Hazardous air
pollutants,” only the data for chemicals listed by the US
EPA as hazardous air pollutants will be considered; if you
want all TRI chemicals to be listed, do not select a
chemical group
2. Chemical – lists the chemical by name, such as 2,4dinitrotoluene
3. NAICS – lists industrial groups by their North American
Industry Classification System (NAICS) classification
4. Industry – lists industries by their broader NAICS
classification. For example, Medicinal and Botanical
Manufacturing is NAICS 325411, however it falls into the
broader industry classification of Chemicals, NAICS 325
5. EJ 3-mile – lists areas by demographics derived from the
Census 2000 Block Group data
6. Tribal – lists facilities either within of within a specified
distance of tribal lands
7. Facility – lists groups of facilities by a variety of factors
8. Geography – lists states and territories of the United States

12

9. Region – lists the ten EPA regions of the United States
10. Year – lists the years from 1988 until present, this is useful
if more than one year of data is being researched, however
not all of the years from 1988 until present are of interest
6. Say you are interested in the number of industrial facilities reporting to the TRI
for the year 2008 that are in the city of Glassboro.
a. Select TRI 2008: PDR 2008 from the DATA drop down menu.
b. Go to Grouping Variables and select City
c. Go to Data Variables→ Counts and select Facility Count
d. To speed up the search, go to Filtering Variables→ Geography and
select New Jersey. This will narrow the search to only facilities in New
Jersey.
e. Select Run Query.
7. Results are given in alphabetical order. If you scroll down, you should see that
there is one facility that reports to the TRI in Glassboro.

8. Say you were interested in the name of this facility, the industry to which it
belongs, and what type of industry to which it belongs.

13

a. Click on Build Query. Notice that the data selections you made
previously are still held in the query. If necessary, you must unclick those
selections or open a new query, however, for this exercise we will leave
them selected.
b. Select Name, Industry, and Industry Type.
c. Select Run Query.
9. You should find that the facility in Glassboro is a core industry in the 311
Food/Beverages/ Tobacco category and that it is called ADM Cocoa Products.

10. You may also export this data to Excel. This is useful for calculating specific data
amongst industries and making comparisons between waste releases among these
industries and over time. To do this, click on the Export To Excel button or go to
File→ Send To→ Spreadsheet.

11. Say you want to visit this facility.
a. Click on Build Query.
b. Go to Grouping Variables and select TRIF ID. **This step is crucial
otherwise Step F and Step H will not work.**
c. Select Run Query.
d. Click on City to alphabetize the list according to city name.
14

e. Go to the entry for Glassboro and click on the blue box to the far left of
the entry.

f. Click on the Export to Google Maps button.

g. This should open a browser displaying the location of ADM Cocoa
Products.

h. If you have Google Earth installed, you may also search the location in
Google Earth. Click on the Export to Google Earth button.

15

i.

This should open Google Earth and display the location of ADM Cocoa
Products.

This concludes the Introductory Tutorial, for a more in-depth Tutorial, see the following
Advanced Tutorial.
1.3.4. Advanced Tutorial
This tutorial will demonstrate how TRI.NET may be used to analyze industry data for
toxic releases. The focus of the tutorial will be on the pharmaceutical sector. The top 20
chemical pollutants in the 2008 TRI for this sector will be determined, as well as the

16

mass of each chemical released. For those who are new to using TRI.NET, it is
recommended that the 1.3.3. Introductory Tutorial be completed first.

1. Open TRI.NET.
2. Click on “Build Query”
3. Save the query as “1.3.4. Advanced Tutorial.”
4. Go to the DATA drop down list and select TRI 2008: PDR 2008. This will
ensure that only data from the 2008 TRI will be analyzed.
5. Go to “Grouping Variables.”
6. Select “Chemical.” This will group the data by chemical, allowing for quick
selection of the top 20 TRI chemicals in the pharmaceutical sector for 2008.
7. Go to “Data Variables”→ “Waste Quantities.”
8. Select “Total Waste Managed.” Alternatively, each of the individual waste
groups (8.1-8.8) may be selected.
9. Go to “Filtering Variables.”→ “NAICS.”
10. Select 325411 Medicinal and Botanical Manufacturing and 325412
Pharmaceutical Preparation Manufacturing. These NAICS codes correspond
to the pharmaceutical manufacturing sector. Notice that the codes both begin with
3254. This corresponds to the broader category of Pharmaceutical and Medicine
Manufacturing. If this option was selected, all four of the 3254 industrial
categories will be analyzed. However, this study is not interested in 325413 InVitro Diagnostic Substance Manufacturing or 325414 Biological Product (except
Diagnostic) Manufacturing. Thus only the first two NAICS codes under the 3254
category are selected.
17

11. Click on “Run Query.”
12. Expand the columns. To do this, hover over the headings until ↔ appears, then
double-click. This capability works similarly to Microsoft Excel®.
13. Put the chemicals in order of the highest mass of waste to the lowest. To do this,
click on the right side of the Total Waste Managed (8.1-8.8) heading. This will
put the chemicals in order from lowest to highest mass of waste. Click on the right
side again and the chemicals will be put in order from highest to lowest mass of
waste.
14. Save the query.
15. The results should resemble those below:
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16. This data may then be exported to Excel®, Notepad®, or another browser for
further analysis.
1.4. TRI Historical Changes
The TRI is a powerful tool for assessing the environmental impact of individual
companies, corporate sectors, and American industries as a whole. However, there are a
series of considerations that must be accounted for when reviewing current and historical
TRI data. The most significant of these factors are the limitations on what defines a
company that must report under the TRI program as well as what chemicals are defined
as “toxic” by the EPA. Although TRI data provides a useful means of determining key
areas for environmental improvement, it may guide the user to dismissing specific
opportunities for emissions reductions. In addition, the TRI is not the best tool for
reducing other specific types of emissions, such Hazardous Air Pollutants (HAPs) and
Criteria Air Pollutants (CAPs). Although many TRI chemicals are also HAPs or CAPs, a
chemical need not fall under these categories to be listed in the TRI. For example, an
HAP is defined as an air pollutant that has an adverse human health effect, such as
cancer. HAPs are one of the six CAPS defined in the Clean Air Act by the EPA, another
example being particulates. Although many HAPs are defined in the TRI, particulates are
not.1 By understanding the TRI, however, one may narrow the scope for potential
environmental improvement opportunities and target documented problematic areas. This
allows for the design of emissions reductions systems that are guided by flexibility and a
larger reduction potential.

19

TRI reporting began in 1988, however, many of the chemicals and manufacturing
companies that are included in the TRI database were not required to report at that time.
In 1998, a large number of industries were added to the TRI. These include metal and
coal mining, electrical utilities, chemical wholesale distributors, petroleum bulk
terminals/bulk storage, hazardous waste treatment facilities, and solvent recovery
facilities. 5 It is important here to discuss the TRI definition of a “solvent recovery
facility,” as it directly relates to pharmaceutical solvent recovery. According to the
Standard Industrial Classification (SIC) Code for TRI Industries, a solvent recovery
facility is a “facility engaged in solvent recovery, limited to facilities primarily engaged
in solvents recovery services on a contract or fee basis.” In addition, “refuse systems” are
required to report to the TRI. This includes hazardous waste treatment and disposal
facilities. As previous research has shown, common practice in the pharmaceutical
industry is to send solvent waste to off-site disposal, primarily incineration, and off-site
recovery. Therefore, a better evaluation of the pharmaceutical TRI could be achieved by
analyzing the TRI volumes from these industrial sectors. However, no differentiation is
made as to what percentage of the waste sent to solvent recovery/hazardous waste
treatment/disposal facilities is allotted to the pharmaceutical sector or other industries. In
addition to the aforementioned industries added to the TRI in 1998, there are conditions
that require any industry to report regardless of the sector in which it operates. These
conditions extend the requirement to report to the TRI to any federal facility in an SIC
code, a facility that employs ten or more full-time employees, and a facility which
manufactures or processes 25,000 pounds of a TRI chemical or otherwise uses over
10,000 pounds of a TRI chemical over a calendar year. In addition to this, much more
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stringent rules are applied to facilities handling PBT (Persistent, Bioaccumulative, and
Toxic) chemicals.5
In addition to changes in the facilities required to report to the TRI, the list of chemicals
considered “toxic” under the TRI has expanded since its inception in 1987. These
changes shall be discussed with relation to the pharmaceutical industry. Figure 2 displays
the total waste managed by the pharmaceutical sector as reported to the TRI for the years
of 1991 through 2008.
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Figure 2. Total Waste Managed by the Pharmaceutical Sector (325411 and 325412) as
Reported to the TRI from 1991 to 2008.

Prior to 1991, reporting to the TRI was voluntary, and as such, waste quantities attributed
to the pharmaceutical sector were negligible. Thus, Figure 2 only includes TRI quantities
reported after 1991. To better explain the data represented in Figure 3, the time periods
presented will be separated into three distinct segments – Segment 1: 1991 through 1993,
Segment 2: 1994 through 2000, and Segment 3: 2001 through 2008.
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For Segment 1, 1991, 1992, and 1993 display TRI waste allocations of 280 MM kg, 300
MM kg, and 224 MM kg, respectively. These values can be attributed to an expanding
U.S. pharmaceutical industry as well as government programs. The first program is the
33/50 Program, the US EPA’s first initiative at reducing toxic releases. This program set
goals of a 33% reduction by 1992 and a 55% reduction by 1995. This program helps to
explain the emissions reductions of 300 MM kg to 224 MM kg (25%) between 1992 and
1993, as well as the reductions of 300 MM kg to 180 MM kg (38%) between 1992 and
1995. These reductions do not meet program goals, but must be taken into consideration
with a second government program working simultaneously. This program was first
considered in 1991 and involved a three-phase approach to broaden the TRI. The first
phase of the program began in 1993, with the addition of specific Resource Conservation
and Recovery Act (RCRA) chemicals as well as specific hydroflourocarbons (HCFCs). In
addition, the specific requirements for reporting were changing, not solely in reference to
the actual chemical, but changes were made that allowed reporting companies to omit
specific TRI chemicals based upon production methods of a chemical, physical attributes,
and other factors.6 As can be seen, it is difficult to attribute trends in this segment to a
single factor, as both the TRI and the pharmaceutical industry were undergoing a wide
number of changes.
For Segment 2, a steadier trend begins to emerge. The increase of reported TRI waste
may still be partially attributed to a growing US pharmaceutical industry. In addition, the
aforementioned three-phase program completely entered into its first phase in 1994. On
November 30, 1994, 286 chemicals and categories were added to the TRI. This nearly
doubled the number of chemicals to be reported to the TRI from 316 in 1993 to 602 in
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1994. May 1, 1997 marked implementation of the second phase of the program, with an
expansion of the facilities required to report to the TRI. This included an estimated
increase of 6,600 facilities reporting to the TRI. The third phase began on October 1,
1997, and was focused on chemical use reporting. The two topics most relevant to the
data in Figure 2 were a further expansion on chemical use and expansion on the TRI to
collect information on how chemicals are used. In addition to this program, further
alterations were made to the TRI regulations between 1998 and 2000. These included the
removal of “chlorosilanes”, addition of dioxin and dioxin-like compounds, and addition
of Persistent, Bioaccumulative, and Toxic (PBT) chemicals to the TRI. 6 The vast
expansion of the TRI and the pharmaceutical industry as a whole resulted in a nearly
steady increase in the amount of waste reported to the TRI by the pharmaceutical industry
between 1994 (170 MM kg) and 2000 (226 MM kg).
Segment 3 of Figure 2 displays the amount of TRI waste allocated to the pharmaceutical
sector for reporting years 2001 through 2008. With expansion of the facilities required to
report to the TRI and the list of chemicals included in the TRI mostly complete, a picture
of the waste reductions and trends is more apparent. Figure 3 displays the total waste
managed by the pharmaceutical sector as reported to the TRI for the years of 2001
through 2008.
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Figure 3. Total Waste Managed by the Pharmaceutical Sector (325411 and 325412) as
Reported to the TRI from 2001 to 2008.

As can be seen in Figure 3, there is a linear decrease in the amount of TRI waste
allocated to the pharmaceutical industry. During this time period, there was an overall
reduction of 235 MM kg of waste in 2001 to 87.8 MM kg of waste in 2008. This data
displays that the pharmaceutical industry has increased its focus on two areas, waste and
emissions reductions, as well as reducing the amount of toxic chemicals used within its
processes.
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Chapter 2
Chapter 2: Life Cycle Assessment and its Application to the Pharmaceutical Industry

Life Cycle Assessment and its Application to the Pharmaceutical Industry
Portions of this chapter are taken directly from "LCA approach to the analysis of solvent
waste issues in the pharmaceutical industry" (Raymond, M.J., C.S. Slater, and M.J.
Savelski. "LCA approach to the analysis of solvent waste issues in the pharmaceutical
industry." International Journal of Green Chemistry. 12 (2010): 1826-1834) with the
permission of Sarah Ruthven and Gill Cockhead. 3
Reproduced by permission of The Royal Society of Chemistry.
The article may be found online at the following location:
http://pubs.rsc.org/en/Content/ArticleLanding/2010/GC/c003666h
2.1. Introduction to the Use of LCA in the Pharmaceutical Industry *
Life Cycle Assessment (LCA) is a systematic method for analyzing the environmental
impact of a product, process, or service through a cradle-to-grave approach. A cradle-tograve approach assesses the environmental impact of the manufacture, use, and disposal
of a material. This approach considers all effects from the point at which materials are
gathered from the earth until these materials are returned to the earth. 7 This allows for a
comprehensive understanding of the overall environmental effects of a process, allowing
the analyst to recognize problems and solutions that a single-issue approach does not
readily identify. 8 The International Standards Organization (ISO) has issued a
methodology for LCA development and interpretation, including ISO documents ISO14040 to ISO-14047.9 Software packages with extensive process and environmental data,

*

Reproduced by permission of the Royal Society of Chemistry:
http://pubs.rsc.org/en/Content/ArticleLanding/2010/GC/c003666h
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such as SimaPro 7.1® (PRé Consultants, Amersfoort, Netherlands), are also available to
aid in the development and analysis of an LCA.
The methodology for developing an LCA includes the following steps: Goal Definition
and Scoping, Inventory Analysis, Impact Assessment, and Interpretation. Goal Definition
and Scoping involves defining the product or process to be assessed, establishing the
context of the assessment, and defining the boundaries of that assessment. Inventory
Analysis involves indentifying and quantifying all energy and materials used and all
environmental emissions throughout the product or process’s life cycle. Impact
Assessment involves assessing any potential human and ecological effects from the
inventory. Interpretation involves evaluating the Inventory Analysis and Impact
Assessment results to make an informed decision on which process or product is
environmentally superior according to the Goal Definition. 7 The development of an LCA
is not linear; throughout the process it is necessary to return to previous steps and
interpret the results found and the relation of these results to other steps in the LCA
process. This method of evaluating processes has proven successful in a variety of
industries, including electronics, production of electricity, and transportation fuels. It has
been applied to pharmaceuticals, although to a smaller extent. Applications have included
catalyst selection for processing an intermediate, a comprehensive study on a
pharmaceutical product by GlaxoSmithKline, and an analysis of Vitamin B12
production.10
Life Cycle Assessment is unique in that it provides a comprehensive view of the
environmental impact of a product or process. Through this comprehensive view, LCA
avoids shifting environmental issues from one source to another. 7 Through life cycle
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assessment of a series of case studies, it will be demonstrated that implementing a solvent
recovery or reduction system into pharmaceutical manufacturing processes can
significantly reduce the emissions associated with the process. The importance of
solvents and solvent use in the manufacture of complex drug products often comes as a
surprise to analysts, as was reported by GlaxoSmithKline (GSK). 11 Although solvents
rarely enter into reaction chemistry, their use constitutes a majority of the mass and
energy demand in the pharmaceutical industry. 80-90% of reaction mass and
approximately 60% of energy use in the production of an active pharmaceutical
ingredient (API) is attributed to solvents. 12 These solvents are used in reactions for API
synthesis, providing a medium for reactions to take place, as well as separation and
washing steps used to purify the API produced during the reaction. It is common practice
in the pharmaceutical industry to incinerate solvent waste both on-site and off-site.13 Two
environmental incentives for life cycle analysis of pharmaceutical solvent use and
recovery exist due to the current practices of solvent use and incineration. The first
incentive is that by recycling an increased proportion of solvent, less solvent must be
produced for use as a virgin solvent feed. The second incentive is that the inventory of
solvent waste to be treated is significantly decreased. Both solvent manufacture and
disposal contribute significant proportions to the life cycle emissions of an API and will
be further elaborated later.
2.2. Results of Application of the TRI and LCA to the Pharmaceutical Industry
2.2.1 Current Situation
As discussed previously, the pharmaceutical industry has reduced TRI waste from
235MM kg in 2001 to 87.8 MM kg in 2008. However, the production of 1 kg of API still
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results in 25 to 100 kg of waste. Before ways to reduce this waste can be discussed, one
must understand how this waste is generated. Figure 4 displays a breakdown of the
pharmaceutical TRI waste for reporting year 2008.

Various Other Solvents
Methanol
Formic Acid

Ammonia
N,N-Dimethylformamide
N-Methyl-2-Pyrrolidone

N-Butyl Alcohol

Chlorobenzene

Dichloromethane

Acetonitrile
Toluene

Figure 4. Breakdown of Pharmaceutical TRI Waste for Reporting Year 2008.

Displayed in Figure 4 are the top ten pharmaceutical TRI wastes. All of the top ten
pharmaceutical TRI wastes are attributed to solvents. Non-solvent chemicals are
included, however only appear in small quantities in the section labeled “Various Other
Solvents.” It should also be noted that other common pharmaceutical solvents, such as
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acetone, do not appear in Figure 4 since they are not categorized as TRI wastes. These
top ten solvents account for 72% of the total pharmaceutical TRI waste. It must be
reiterated that of the remaining 28%, a large portion is also attributed to solvent use. As
stated previously, 80-90% of the total mass that goes into making an API is attributed to
solvents. Figure 4 demonstrates that although the pharmaceutical sector has greatly
reduced TRI wastes, solvent waste still constitutes a large majority of the total. In
addition, the top four pharmaceutical TRI chemicals – methanol, dichloromethane,
toluene, and acetone – constitute 64% of the total pharmaceutical TRI waste.
Furthermore, these four solvents have consistently been the top four pharmaceutical TRI
wastes throughout 2001 to 2008. Figure 5 displays the amount of waste allocated to each
of the top four pharmaceutical TRI chemicals for reporting years 2001 to 2008.
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Figure 5. Amount of Waste Attributed to Each of the Top Four TRI Chemicals Reported
by the Pharmaceutical Sector.
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Of these four wastes, methanol consistently made up the largest portion of the TRI waste,
toluene moved from the second to third largest contributor, switching positions with
dichloromethane, and acetonitrile remained the fourth largest contributor. The mass of
methanol waste alone was reduced by 76%, from 109 MM kg to 25.9 MM kg. By using
the TRI to determine this trend, the pharmaceutical industry may focus on reducing
emissions within problem areas – most notably these four recurring top TRI chemicals.
2.2.2. Life Cycle Inventory of the Pharmaceutical TRI
In order to fully understand the environmental impact of the TRI, a life cycle analysis
must be completed. The TRI only provides data on the amount of waste produced at a
facility, but does not consider the amount of emissions that are attributed to that waste.
By conducting an LCA, one may determine the full impact of that waste on the
environment.
A Life Cycle Inventory (LCI) is a record of the emissions attributed to a product through
raw material acquisition, manufacture, use, and final disposal, and is crucial to the
development of an LCA. Life cycle inventories were created for manufacture and
disposal (incineration) of each of the top ten pharmaceutical TRI solvents. A life cycle
inventory was made for the remaining chemicals, in which they were modeled as a
“generic solvent.” Table 2 displays the life cycle inventory for the manufacture of 1 kg of
each of the top ten pharmaceutical TRI solvents and a “generic solvent."
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Table 2. Life Cycle Inventory for the Manufacture of 1 kg of the Top 10 TRI Solvents
and a "Generic Solvent."

Raw
kg
Methanol 8.34E-01
Dichloromethane 2.10E+00
Toluene 1.36E+00
Acetonitrile 1.54E+00
Chlorobenzene 1.07E+01
n -Butyl Alcohol 2.21E+00
N-Methyl-2-Pyrrolidone 2.81E+00
N,N -Dimethylformamide 1.78E+00
Ammonia 1.02E+00
Formic Acid 1.88E+00
Generic Solvent 1.74E+00

Air
CO2
kg
kg
6.47E-01 6.40E-01
2.36E+00 2.31E+00
1.21E+00 1.19E+00
1.97E+00 1.95E+00
1.04E+01 1.02E+01
1.62E+00 1.60E+00
3.82E+00 3.78E+00
1.85E+00 1.83E+00
1.84E+00 1.83E+00
2.40E+00 2.37E+00
1.78E+00 1.75E+00

Water
kg
6.39E-03
3.30E-01
3.87E-03
1.44E-01
1.13E+00
2.54E-02
2.82E-01
3.60E-01
3.35E-02
9.42E-02
1.22E-01

Soil
kg
1.27E-04
2.44E-06
3.46E-07
6.80E-04
3.87E-04
3.50E-04
1.45E-03
2.11E-03
1.21E-03
2.44E-03
1.66E-04

Total
kg
6.54E-01
2.69E+00
1.21E+00
2.12E+00
1.16E+01
1.65E+00
4.11E+00
2.21E+00
1.87E+00
2.50E+00
1.91E+00

In Table 2, Raw refers to the mass of raw materials required to manufacture 1 kg of a
solvent, Air refers to the mass of emissions to air from the manufacture of 1 kg of a
solvent, CO2 refers to the mass of CO2 emissions from the manufacture of 1 kg of a
solvent, Water refers to the mass of emissions to water from the manufacture of 1 kg of a
solvent, Soil refers to the mass of emissions to soil from the manufacture of 1 kg of a
solvent, and Total refers to the sum of the emissions to air, water, and soil from the
manufacture of 1 kg of a solvent. Figure 6 displays the data in Table 2 in graphical form.
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Figure 6. Life Cycle Inventory for the Manufacture of 1 kg of the Top 10 TRI Solvents
and a "Generic Solvent."

As can be seen in Figure 6, chlorobenzene displays the largest mass of emissions per kg
of solvent manufactured. This will be discussed in more detail in the life cycle analysis.
Table 3 displays the life cycle inventory for the incineration of 1 kg of each of the top ten
pharmaceutical TRI solvents and a “generic solvent.”
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Table 3. Life Cycle Inventory for the Incineration of 1 kg of the Top 10 TRI Solvents and
a "Generic Solvent."

Raw
kg
Methanol 9.97E-02
Dichloromethane 2.80E+00
Toluene 1.25E-02
Acetonitrile 1.78E-01
Chlorobenzene 9.20E-01
n -Butyl Alcohol 1.25E-02
N-Methyl-2-Pyrrolidone 0.00E+00
N,N -Dimethylformamide 1.05E-01
Ammonia 0.00E+00
Formic Acid 4.20E-01
Generic Solvent 1.20E+00

Air
kg
1.93E+00
2.87E+00
3.36E+00
2.16E+00
2.37E+00
2.39E+00
0.00E+00
1.82E+00
0.00E+00
3.53E+00
2.24E+00

CO2
kg
2.88E-01
2.90E+00
9.18E-01
5.20E-01
1.66E+00
3.73E-01
0.00E+00
3.75E-01
0.00E+00
1.03E+00
1.49E+00

Water
kg
0.00E+00
8.32E-04
0.00E+00
0.00E+00
3.12E-04
0.00E+00
0.00E+00
0.00E+00
0.00E+00
0.00E+00
3.44E-04

Soil
kg
0.00E+00
0.00E+00
0.00E+00
0.00E+00
0.00E+00
0.00E+00
0.00E+00
0.00E+00
0.00E+00
0.00E+00
0.00E+00

Total
kg
1.93E+00
2.87E+00
3.36E+00
2.16E+00
2.37E+00
2.39E+00
0.00E+00
1.82E+00
0.00E+00
3.53E+00
2.24E+00

In Table 3, Raw refers to the mass of raw materials required to incinerate 1 kg of a
solvent, Air refers to the mass of emissions to air from the incineration of 1 kg of a
solvent, CO2 refers to the mass of CO2 emissions from the incineration of 1 kg of a
solvent, Water refers to the mass of emissions to water from the incineration of 1 kg of a
solvent, Soil refers to the mass of emissions to soil from the incineration of 1 kg of a
solvent, and Total refers to the sum of the emissions to air, water, and soil from the
incineration of 1 kg of a solvent. Figure 7 displays the data in Table 3 in graphical form.
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Figure 7. Life Cycle Inventory for the Incineration of 1 kg of the Top 10 TRI Solvents
and a "Generic Solvent."

As can be seen, there are no emissions associated with the incineration of ammonia.
EcoSolvent® was used to analyze the incineration of each of the solvents in Table 3 and
Figure 7 and ammonia is not included in the EcoSolvent ® database. Therefore, ammonia
was excluded from the analysis. In addition, N-methyl-2-pyrrolidone is not in the
EcoSolvent® database. However, it was modeled as N,N-dimethylformamide, as both
belong to the same class of dipolar aprotic solvents. Table 4 displays the cradle-to-grave
life cycle inventory for 1 kg of each of the top ten pharmaceutical TRI solvents and a
“generic solvent.”
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Table 4. Cradle-to-Grave Life Cycle Inventory for 1 kg of the Top 10 TRI Solvents and a
“Generic Solvent.”

Raw
kg
Methanol 9.33E-01
Dichloromethane 4.90E+00
Toluene 1.37E+00
Acetonitrile 1.71E+00
Chlorobenzene 1.16E+01
n -Butyl Alcohol 2.22E+00
N-Methyl-2-Pyrrolidone 2.81E+00
N,N -Dimethylformamide 1.89E+00
Ammonia 1.02E+00
Formic Acid 2.30E+00
Generic Solvent 2.94E+00

Air
kg
2.58E+00
5.23E+00
4.56E+00
4.13E+00
1.28E+01
4.01E+00
3.82E+00
3.67E+00
1.84E+00
5.93E+00
4.02E+00

CO2
kg
9.28E-01
5.21E+00
2.11E+00
2.47E+00
1.19E+01
1.97E+00
3.78E+00
2.20E+00
1.83E+00
3.40E+00
3.24E+00

Water
kg
6.39E-03
3.31E-01
3.87E-03
1.44E-01
1.13E+00
2.54E-02
2.82E-01
3.60E-01
3.35E-02
9.42E-02
1.23E-01

Soil
kg
1.27E-04
2.44E-06
3.46E-07
6.80E-04
3.87E-04
3.50E-04
1.45E-03
2.11E-03
1.21E-03
2.44E-03
1.66E-04

Total
kg
2.59E+00
5.56E+00
4.57E+00
4.28E+00
1.39E+01
4.03E+00
4.11E+00
4.03E+00
1.87E+00
6.02E+00
4.15E+00

In Table 4, Raw refers to the mass of raw materials required to manufacture and
incinerate 1 kg of a solvent, Air refers to the mass of emissions to air from the
manufacture and incineration of 1 kg of a solvent, CO2 refers to the mass of CO2
emissions from the manufacture and incineration of 1 kg of a solvent, Water refers to the
mass of emissions to water from the manufacture and incineration of 1 kg of a solvent,
Soil refers to the mass of emissions to soil from the manufacture and incineration of 1 kg
of a solvent, and Total refers to the sum of the emissions to air, water, and soil from the
manufacture and incineration of 1 kg of a solvent. Figure 8 displays the data in Table 4 in
graphical form.
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Figure 8. Cradle-to-Grave Life Cycle Inventory for 1 kg of the Top 10 TRI Solvents and
a “Generic Solvent.”

As can be seen in Figure 8, chlorobenzene displays the largest mass of cradle-to-grave
life cycle emissions. This will be discussed in more detail in the life cycle analysis. In
addition, Table 4 and Figure 8 exclude the mass of emissions for incineration of 1 kg of
ammonia and model the mass of emissions for incineration of 1 kg of N-Methyl-2pyrrolidone as that for N,N-dimethylformamide, as ammonia and N-methyl-2-pyrrolidone
are not included in the EcoSolvent ® database.
2.2.3. Life Cycle Analysis of the Pharmaceutical TRI
The data displayed in Figure 6, Figure 7, and Figure 8 was used to create a life cycle
analysis of the pharmaceutical TRI. The life cycle analysis was completed on two bases.
The first is for the total waste from the pharmaceutical TRI. For this basis, it was
assumed that the total waste reported by the TRI is equivalent to the raw material amount
used in the API manufacture as well as the amount disposed. In this analysis, the
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emissions generated per kg of solvent from raw material manufacturing (i.e. manufacture
of the actual solvent) (Figure 6), the emissions generated per kg of solvent from
incineration (Figure 7), and cradle-to-grave emissions per kg of solvent (Figure 8) are
multiplied by the amount of solvent used (kg/yr) (Figure 4). This yields the total life
cycle emissions for that particular solvent (MMkg/yr) from manufacture and disposal.
Table 5 shows the overall usage values of the individual solvents. The yearly life cycle
emissions for their manufacture is shown in Figure 9. Figure 10 shows the total yearly
emissions associated with incineration of the solvents as a waste. The overall cradle-tograve life cycle emissions (MMkg/yr), which is the sum of the values represented in
Figure 9 and Figure 10 is presented in Figure 11.

Table 5. Breakdown of Pharmaceutical TRI Waste for Reporting Year 2008.
Solvent
Methanol
Dichloromethane
Toluene
Acetonitrile
Chlorobenzene
n -Butyl Alcohol
N -Methyl-2-Pyrrolidone
N,N -Dimethylformamide
Ammonia
Formic Acid
Various Other Solvents
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Mass
MM kg
25.9
14.2
9.8
6.5
3.7
2.9
2.7
2.7
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2.2
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Figure 9. Emissions from Manufacture of the Pharmaceutical Industry TRI Solvents.
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Figure 10. Emissions from Incineration of the Pharmaceutical Industry TRI Solvents.
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Figure 11. Cradle-to-Grave Emissions of the Pharmaceutical Industry TRI Solvents.

The effect of the life cycle inventories of each of the TRI chemicals becomes much more
apparent in Figure 9 through Figure 11. For example, although chlorobenzene accounts
for only 4% of the total mass of the top 10 TRI solvents, the total life cycle emissions
attributed to chlorobenzene account for 13% of the total TRI cradle-to-grave emissions.
Methanol, which accounts for 29% of the total mass of the top 10 TRI solvents and
constitutes the largest mass of a pharmaceutical TRI chemical, contributes 17% to the
total TRI cradle-to-grave-emissions. Out of the top 10 solvents, three contribute half of
the total TRI life cycle emissions, methanol (17%), dichloromethane (20%), and
chlorobenzene (13%). By specifically targeting chemicals such as methanol that are used
in large quantities or chlorobenzene which has a disproportionately large amount of life
cycle emissions when compared to other TRI solvents, one may more effectively reduce
the life cycle emissions associated with a process.
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2.3. Theoretical Use of the TRI to Reduce Life Cycle Emissions of a Facility
As stated, one may utilize information from the TRI and life cycle analysis software to
determine what chemicals to target for “green” process improvements. To demonstrate
this, a theoretical pharmaceutical facility was developed for the basis of a case study. The
life cycle emissions of this facility were determined by taking the total TRI emissions in
manufacture (Figure 9), incineration (Figure 10), and overall life cycle (Figure 11), and
dividing by 152 – the total number of pharmaceutical facilities that reported to the TRI
for reporting year 2008. This allowed for an “average” life-cycle analysis to be created
for a single facility within the pharmaceutical industry. The emissions from manufacture
of TRI solvents for this facility are displayed in Table 6 and Figure 12.
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Table 6. Emissions from the Manufacture of TRI Solvents for an Average Pharmaceutical Facility.

Total Waste
Managed
Raw
Air
MM kg MM kg MM kg
Methanol
0.17
0.14
0.11
Dichloromethane
0.09
0.20
0.22
Toluene
0.06
0.09
0.08
Acetonitrile
0.04
0.07
0.08
Chlorobenzene
0.02
0.26
0.25
n -Butyl Alcohol
0.02
0.04
0.03
N -Methyl-2-Pyrrolidone
0.02
0.05
0.07
N,N -Dimethylformamide
0.02
0.03
0.03
Ammonia
0.02
0.02
0.03
Formic Acid
0.01
0.03
0.03
Generic Solvents
0.10
0.17
0.17
Total
0.58
1.09
1.11
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Water
MM kg
1.09E-03
3.10E-02
2.50E-04
6.21E-03
2.74E-02
4.83E-04
5.03E-03
6.36E-03
5.60E-04
1.35E-03
1.17E-02
9.14E-02

Soil
Total
MM kg MM kg
2.17E-05
0.11
2.28E-07
0.25
2.24E-08
0.08
2.92E-05
0.09
9.36E-06
0.28
6.67E-06
0.03
2.59E-05
0.07
3.73E-05
0.04
2.02E-05
0.03
3.50E-05
0.04
1.60E-05
0.18
2.01E-04
1.21
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Figure 12. Emissions from the Manufacture of TRI Solvents for an Average
Pharmaceutical Facility.

The emissions from incineration of TRI solvents for this facility are displayed in Table 7
and Figure 13.
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Table 7. Emissions from the Incineration of TRI Solvents for an Average Pharmaceutical Facility.

Methanol
Dichloromethane
Toluene
Acetonitrile
Chlorobenzene
n -Butyl Alcohol
N -Methyl-2-Pyrrolidone
N,N -Dimethylformamide

Ammonia
Formic Acid
Generic Solvents
Total

Total Waste
Managed
Raw
Air
MM kg MM kg MM kg
0.17
0.02
0.33
0.09
0.26
0.27
0.06
0.00
0.22
0.04
0.01
0.09
0.02
0.02
0.06
0.02
0.00
0.05
0.02
0.00
0.03
0.02
0.00
0.03
0.02
0.00
0.00
0.01
0.01
0.05
0.10
0.12
0.21
0.58
0.44
1.34
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Water
MM kg
0.00E+00
7.79E-05
0.00E+00
0.00E+00
7.54E-06
0.00E+00
0.00E+00
0.00E+00
0.00E+00
0.00E+00
3.30E-05
1.18E-04

Soil
Total
MM kg MM kg
0.00E+00
0.33
0.00E+00
0.27
0.00E+00
0.22
0.00E+00
0.09
0.00E+00
0.06
0.00E+00
0.05
0.00E+00
0.03
0.00E+00
0.03
0.00E+00
0.00
0.00E+00
0.05
0.00E+00
0.21
0.00E+00
1.34

MMkg of Emissions

0.35

0.30
0.25
0.20
0.15
0.10

Soil

0.05

Water

0.00

Air

Figure 13. Emissions from the Incineration of TRI Solvents for an Average
Pharmaceutical Facility.

The total life-cycle emissions for this facility are displayed in Table 8 and Figure 14.
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Table 8. Total Life Cycle Emissions from the TRI Solvents for an Average Pharmaceutical Facility.

Methanol
Dichloromethane
Toluene
Acetonitrile
Chlorobenzene
n -Butyl Alcohol
N -Methyl-2-Pyrrolidone
N,N -Dimethylformamide

Ammonia
Formic Acid
Generic Solvents
Total

Total Waste
Managed
Raw
Air
MM kg MM kg MM kg
0.17
0.16
0.44
0.09
0.46
0.49
0.06
0.09
0.30
0.04
0.07
0.18
0.02
0.28
0.31
0.02
0.04
0.08
0.02
0.05
0.10
0.02
0.03
0.06
0.02
0.02
0.03
0.01
0.03
0.08
0.10
0.28
0.39
0.58
1.52
2.46
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Water
MM kg
1.09E-03
3.10E-02
2.50E-04
6.21E-03
2.74E-02
4.83E-04
5.03E-03
6.36E-03
5.60E-04
1.35E-03
1.18E-02
9.16E-02

Soil
Total
MM kg MM kg
2.17E-05
0.44
2.28E-07
0.52
2.24E-08
0.30
2.92E-05
0.18
9.36E-06
0.34
6.67E-06
0.08
2.59E-05
0.11
3.73E-05
0.07
2.02E-05
0.03
3.50E-05
0.09
1.60E-05
0.40
2.01E-04
2.55

MMkg of Emissions

0.60
0.50

0.40
0.30

0.20

Soil

0.10

Water

0.00

Air

Figure 14. Total Life Cycle Emissions from the TRI Solvents for an Average
Pharmaceutical Facility.

As can be seen, the total amount of waste from the average pharmaceutical plant is
580,000 kg. This equates to 2,550,000 kg of total life cycle emissions, 1,210,000 kg of
emissions from solvent manufacture and 1,340,000 kg of emissions from incineration.
This correlates to 75% of the total emissions, with the remainder belonging to in-process
emissions. 14 When this is taken into consideration, a single pharmaceutical facility
produces 3,400,000 kg of life cycle emissions. The emissions profile for a hypothetical
"average" single pharmaceutical industry is displayed in Figure 15.
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25%
36%

Manufacture
Incineration
In Process Use
39%

Emissions = 3.4 MM kg

Figure 15. Emissions Profile for a Single Pharmaceutical Facility.

By using three basic green engineering techniques, solvent recovery, “green” solvent
selection, and telescoping these emissions may be significantly reduced.
Solvent recovery has been thoroughly discussed in relation to the TRI. To demonstrate
the potential emissions reductions of a solvent recovery system in a pharmaceutical plant,
the above “average pharmaceutical facility” was considered. Assuming that 80% of
solvents are recovered and recycled back into the process, an 80% reduction in the
emissions from both manufacture and incineration can be expected. This results in total
life cycle emissions for an average pharmaceutical facility of 1,360,000 kg of emissions –
24,200 kg of emissions from solvent manufacture, 26,800 kg of emissions from
incineration, and 85,000 kg of emissions from in-process use. This is displayed in Figure
16.

47

1.6

MMkg of Emissions

1.4
1.2
1

UNCHANGED
0.8
0.6

BASE

BA SE

GREEN

GREEN

Manufacture

Incineration

0.4
0.2
0
In Process Use

Figure 16. Solvent Recovery Scenario for an Average Pharmaceutical Facility Versus the
Base Case.

In Figure 16, “Base” refers to the base case scenario for the average pharmaceutical
facility and “Green” refers to the solvent recovery scenario.
A second method for reducing the emissions of an average pharmaceutical facility is by
selecting a “green” solvent. This means that a solvent used in a pharmaceutical process is
replaced by a solvent that has a lesser impact on the environment, i.e. it has lower
emissions from manufacture, lower emissions from incineration, and/or a smaller mass of
the “green” solvent is required to achieve the same effects as using the original solvent.
To model a decrease in the emissions of a pharmaceutical facility be selecting “greener”
solvents, a ratio of the emissions of “green” solvents to other solvents was developed.
The top 10 TRI solvents, discussed previously, were split into two categories. The five
“greenest” solvents – those with the lowest emissions from manufacture and incineration
– were grouped together as well as the five least “green” solvents. The emissions per kg
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of solvent for manufacture of the five greenest solvents was averaged. This was divided
by the average of the emissions per kg of solvent for manufacture of the five least green
solvents. The same process was used to determine a ratio for the kg of emissions for
incineration of green solvents versus environmentally unfavorable solvents. The
emissions from solvent manufacture for the average pharmaceutical facility were
multiplied by the first ratio to determine the reduction of emissions from solvent
manufacture if a facility replaced a solvent with a “green” solvent. The green solvents
displayed a ratio of approximately 33% of the emissions from manufacture of the
environmentally unfavorable solvents. The emissions from incineration were multiplied
by the second ratio to determine the reduction of emissions from incineration if a facility
replaced a solvent with a “green” solvent. The green solvents displayed a ratio of
approximately 80% of the emissions from incineration of the environmentally
unfavorable solvents. This resulted in 392,000 kg of emissions from solvent manufacture
and 1,063,000 kg of emissions from incineration. The emissions from in-process use
remained unchanged. The total emissions from an average pharmaceutical facility
employing “green” solvents is 2,310,000 kg, a 32% reduction. This is displayed in Figure
17.
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Figure 17. “Green” Solvent Scenario for an Average Pharmaceutical Facility Versus the
Base Case.

In Figure 17, “Base” refers to the base case scenario for the average pharmaceutical
facility and “Green” refers to the “green” solvent scenario.
A third method for reducing the emissions of a pharmaceutical facility is by
“telescoping.” Telescoping involves reducing the number of steps in a process. For
example, a pharmaceutical production process may require a series of three separation
steps, each employing a different unit operation. By reducing this to two steps, one may
expect to reduce the emissions of the pharmaceutical process. In the “average
pharmaceutical facility” model, telescoping was applied, assuming that the facility
employed a multistep process and reduced the number of necessary unit operations by
one-third. This was then assumed to correlate to a 33% reduction in emissions from
solvent manufacture, incineration, and in-process use. This results in total life cycle
emissions for an average pharmaceutical facility of 2,245,000 kg of emissions – 796,000
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kg of emissions from solvent manufacture, 885,000 kg of emissions from incineration,
and 564,000 kg of emissions from in-process use. This is displayed in Figure 18.
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Figure 18. Telescoping Scenario for an Average Pharmaceutical Facility Versus the Base
Case.

In Figure 18, “Base” refers to the base case scenario for the average pharmaceutical
facility and “Green” refers to the telescoping scenario.
A final green pharmaceutical process improvement was modeled. In this process, all three
previously discussed green engineering options were applied. By utilizing all three
process improvements, the maximum emissions reductions may be expected. The initial
emissions from manufacture and incineration of solvent waste of the average
pharmaceutical facility were reduced by 80% to simulate implementation of a solvent
recovery process. These emissions were then further reduced, assuming that
environmentally unfriendly solvents were replaced by "greener" solvents, as described
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earlier. Finally, these emissions were reduced by 33%, assuming that telescoping allowed
a reduction of 33% of the total unit processes employed in the pharmaceutical production
process. This resulted in a reduction of the total life cycle emissions of the
pharmaceutical facility of 78%, or 2,650,000 kg of emissions, to a total of 756,000 kg of
emissions per year. Emissions from solvent manufacture were reduced by 1,150,000
kg/year to a total of 51,800 kg of emissions per year. Emissions from incineration were
reduced by 1,200,000 kg/year to a total of 140,000 kg of emissions per year. Emissions
from in-process use were reduced by 295,000 kg/year to a total of 564,000 kg of
emissions per year. This is displayed in Figure 19.
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Figure 19. Scenario Using All Three Green Process Improvements for an Average
Pharmaceutical Facility Versus the Base Case.

In Figure 19, “Base” refers to the base case scenario for the average pharmaceutical
facility and “Green” refers to the scenario employing all three green process
improvements.
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2.4. Comparison of Solvent Life Cycle Emission Routes*
The general life cycle of a solvent includes its production, in-process use, and waste
treatment. The environmental effects of solvent production and waste treatment are
often overlooked; however, these contribute significantly to the life cycle emissions
for the production of an API. A basic flow chart of the life cycle emissions of a
solvent can be found in Figure 20.

Emissions

Solvent Manufacture

(SimaPro

7.1 ®)

Emissions

In Process Use

(SimaPro

7.1 ®)

Emissions

Incineration

(EcoSolvent

®)

Figure 20. Basic Flow Chart of Solvent Life Cycle and Associated Emissions.

A life cycle assessment has been performed on a variety of common solvents, using
EcoSolvent ® (Safety and Environmental Group, Zurich, Switzerland) and SimaPro
7.1® software packages. In order to demonstrate the environmental effect of solvent
use on a broader scale, in-process emissions were neglected. In the preliminary
analysis, these emissions were neglected based on the assumption that no solvent was
to be consumed during use and that in-process emissions, such as fugitive emissions

*

Reproduced by permission of the Royal Society of Chemistry:
http://pubs.rsc.org/en/Content/ArticleLanding/2010/GC/c003666h
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and emissions due to pumping, mixing, and heating, are negligible in comparison to
the emissions from solvent production and waste treatment. In-process emissions will
be discussed in further detail in the following case studies. It was assumed that no
solvent was recovered and that all solvent waste was treated by incineration. It was
also assumed that energy was recovered during incineration by recovering heat
generated while incinerating waste by steam production. This was used to offset CO 2
waste and energy usage by decreasing the amount of energy required to manufacture
solvents and to produce steam. Incineration was assumed to be carried out in-house.
Each life cycle inventory was developed on a 1 kg of solvent basis. Table 9 displays
a summary of the life cycle assessment results for the production of ten commonly
used organic solvents. Included in Table 9 is an analysis for a “generic solvent,”
which is defined in SimaPro 7.1 ® and is an average of the solvents in the SimaPro
7.1® database. The Cumulative Energy Demand (CED) for the production of these ten
solvents was calculated using SimaPro 7.1 ®. The CED is the overall energy
requirement for the life cycle of a component as defined by the life cycle boundaries
set by the analysis. This may include the energy from production, use, and disposal. 15
In this instance, the boundaries were defined as the cradle-to-gate life cycle for the
manufacture of a solvent. The air, water, and soil emissions listed in Table 9 are
defined as the mass of wastes released to air, water, or soil, respectively. The mass of
water in the raw materials is not included in the values listed in Table 9, as SimaPro
7.1® does not differentiate between process water and reaction water. Table 10
displays the water usage associated with the production of 1 kg of each of the solvents
in Table 9. As it can be seen, the required process water, turbine water, and cooling
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water are nearly tenfold higher for THF than any other solvent listed. The organic
solvent data was compared to the life cycle assessment for the production of 1 kg of a
variety of non-organic solvent commodity chemicals.
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Table 9. Life Cycle Analysis for the Production of 1 kg of Various Organic Solvents.

Emissions
a

Raw
Acetone
Acetonitrile
Diethyl Ether
Ethanol
Hexane
IPA
MeOH
THF
Toluene
Generic Solvent
a

(kg)
1.53E+00
1.54E+00
1.17E+00
1.17E+00
1.59E+00
1.55E+00
8.34E-01
4.01E+00
1.36E+00
1.74E+00

Air
(kg)
1.83E+00
1.97E+00
1.09E+00
1.09E+00
8.84E-01
1.66E+00
6.47E-01
5.52E+00
1.21E+00
1.78E+00

Water
(kg)
2.56E-02
1.44E-01
1.66E-02
1.66E-02
1.75E-01
5.42E-01
6.39E-03
1.26E-01
3.87E-03
1.22E-01

Mass of raw materials consumed excluding water
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Soil
(kg)
7.23E-07
6.80E-04
1.95E-04
2.00E-04
5.93E-03
3.18E-04
1.27E-04
2.31E-03
3.46E-07
1.66E-04

CO2
(kg)
1.80E+00
1.95E+00
1.08E+00
1.08E+00
8.55E-01
1.63E+00
6.40E-01
5.46E+00
1.19E+00
1.75E+00

Total
(kg)
1.86E+00
2.12E+00
1.11E+00
1.11E+00
1.06E+00
2.20E+00
6.54E-01
5.65E+00
1.21E+00
1.91E+00

CED
MJ-Eq
6.73E+01
6.15E+01
4.80E+01
4.80E+01
6.17E+01
6.32E+01
3.76E+01
1.28E+02
6.34E+01
6.51E+01

Table 10. Water Requirements for the Production of 1 kg of Various Organic Solvents.

Cooling
(kg)
Acetone
7.85E+01
Acetonitrile
2.41E+02
Diethyl Ether
3.16E+01
Ethanol
3.17E+01
Hexane
3.53E+01
IPA
4.91E+01
MeOH
1.03E+01
THF
7.09E+02
Toluene
8.97E+01
Generic Solvent 8.13E+01
a

Turbine
(kg)
5.57E+00
1.61E+03
8.14E+02
8.15E+02
1.68E+03
1.49E+03
5.42E+02
1.51E+04
2.70E+00
1.41E+03

Mass of water of unspecified origin
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Fresh
(kg)
1.11E-01
5.22E+00
1.31E+00
1.79E+00
2.33E+00
4.09E+00
1.62E+00
1.67E+01
2.05E-01
1.94E+00

a

Unspecified
Saline
(kg)
(kg)
3.39E-01
3.11E+00
5.92E-01
3.45E+00
2.82E-01
1.46E+00
2.82E-01
1.46E+00
1.50E+00
3.62E+00
5.19E-01
1.35E+01
4.55E-01
2.34E-01
2.94E+00
4.41E+00
6.06E-01
8.25E-01
5.68E-01
9.69E+00

Table 11. Life Cycle Analysis for the Production of 1 kg of Various Commodity Chemicals.
Emissions
a

Raw

(kg)
6.24E-01
1.37E-01
5.01E+00

Ammonia
Sulfuric Acid
TiO2
a

Air
(kg)
2.03E+00
1.54E-01
4.33E+00

Water
(kg)
4.55E-02
9.12E-03
4.33E-01

Soil
CO2
Total
CED
(kg)
(kg)
(kg)
MJ-Eq
1.83E-03 2.02E+00 2.08E+00 4.23E+01
1.54E-04 1.35E-01 1.63E-01 2.36E+00
2.54E-03 4.26E+00 4.77E+00 8.86E+01

Mass of raw materials consumed excluding water

Table 12. Water Requirements for the Production of 1 kg of Various Commodity Chemicals.

Ammonia
Sulfuric Acid
TiO2
a

Cooling
(kg)
5.47E+00
2.26E+00
7.89E+01

a

Turbine
Fresh
Saline Unspecified
(kg)
(kg)
(kg)
(kg)
1.34E+03 1.44E+00 9.70E-01
2.85E+00
4.65E+02 5.64E-01 7.05E-02
4.92E+01
1.15E+04 1.19E+01 2.64E+00
5.94E+01

Mass of water of unspecified origin
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A statistical analysis on production emissions comparing the two sets of data was
performed using StatGraphics Plus 5.1 ® (StatPoint Technologies, Inc, Warrenton,
Virginia). A sample of the results for the commodity chemicals is displayed Table 11
and Table 12.
It was found that the only statistical difference between the production of 1 kg of an
organic solvent and 1 kg of a commodity chemical was in the CED. This is supported
by the notion that over half of organic chemicals require from 0 to 4 MJ of energy for
manufacture as opposed to inorganic chemicals which range from -1 to 3 MJ of
energy. 16 THF was also determined to have a significantly higher CED than the other
organic solvents tested. This was attributed to the fact that the purification of THF
poses unique difficulties, including a variety of severe azeotropes. 17 Although many
of the other solvents tested also display azeotropes in a variety of mixtures, the
azeotrope between THF and water is more energy intensive to overcome. This is
supported by the fact that pressure swing distillation is typically employed in industry
to separate THF and water mixtures. 18 The larger CED can also be associated with the
smaller industrial demand and thus smaller production quantities of THF in
comparison with other solvents. Considering the comparison of solvents to
commodity chemicals, it may be concluded that there is no difference in the mass of
waste attributed to the production of 1 kg of an organic solvent or 1 kg of commodity
chemical; however, there is a significantly larger energy demand for the production of
organic solvents.
The significant effect of solvent reduction is, therefore, attributed to both the larger
CED and the difference in use of the chemicals. Commodity chemicals are commonly
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used to adjust pH, catalyze reactions, and serve as the reactants in chemical processes.
In the modern pharmaceutical industry, multiple steps are employed to produce an
API. During each of these steps, large quantities of organic solvents are in use but do
not enter into reaction stoichiometry. As a result, 80 to 90% of the total mass used in
the production of an API may be attributed to solvents. 12 These solvents are disposed
of rather than recycled, creating a massive environmental deficit from solvent
production and disposal. For many commodity chemicals, the chemical inventory
cannot be reduced without changing reaction pathways, stoichiometries, and catalysis.
For solvents, however, implementation of a solvent recovery system can significantly
decrease the chemical inventory and required raw materials thus decreasing the
environmental footprint.
The life cycle inventories for the production of organic solvents display similar
distributions of emissions. Since the subsequent case studies involve the solvents IPA,
MeOH, and THF, the life cycle inventories of these solvents will be presented and
discussed.
Figure 21 displays the distribution of emissions to air and water for the manufacture
of each of these solvents. Emissions to soil are too low to be appreciated in
Figure 21 and are thus omitted. The mass of total emissions for each solvent is
displayed below each graph. As it can be seen, emissions to air constitute the majority
in each case. IPA is the only solvent to display a significant amount of emissions to
water, approximately 25% compared to 2.2% for THF and 1.0% for MeOH. This may
be attributed to the process used to produce IPA. Currently, IPA is commercially
produced through the hydration of propylene in the presence of a highly concentrated
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sulfuric acid solution. This requires large amounts of reaction water, often employing
propylene as the limiting reagent. It is also notable that a solution of 50% sulfuric
acid and water has 5.5% of total emissions to water, contributing to the elevated
emissions to water for the production of IPA. Other commercial methods for the
production of IPA include hydration in gas/liquid mixed phase using strongly acidic
ion exchange resins, gas phase hydration using strongly acidic solid acid catalysts,
and gas phase hydration by catalysts carrying hetero-poly or inorganic acids. 19 All of
these methods display similar issues with elevated emissions to water. None of the
solvents display an appreciable amount of emissions to soil in comparison to air and
water. Figure 22 displays the composition of the air emissions stream for the
production of each of these solvents, as well as the mass of CO 2 emitted during
production.

Air
Water

Total Emissions: 2.20 kg
IPA

Total Emissions: 0.65 kg
MeOH

Total Emissions: 5.65 kg
THF

Figure 21. Waste Distribution for Production of 1 kg of IPA, MeOH, and THF.

61

CO2
Other

Mass CO2: 1.63 kg
IPA

Mass CO2: 0.63 kg
MeOH

Mass CO 2: 5.46 kg

THF

Figure 22. Distribution of Emissions to Air for Production of 1 kg of IPA, MeOH, and
THF.

Figure 22 demonstrates that carbon dioxide constitutes the vast majority of emissions
to air for each of these solvents, between 96 and 99%. This is attributed to
combustion reactions within the production processes and transportation to and from
the manufacturing plant. This is in agreement with a study done in the Netherlands
that found that the majority of CO 2 emissions came from a small number of
manufacturing plants. Among these plants, the refining, petrochemical production and
chemical production sectors were the first, second, and third largest offenders,
respectively. These emissions were directly attributed to combustion reactions. 20 A
study conducted in the United States associates approximately 97% of air emissions
from transportation to CO 2.11 This exemplifies the high proportion of CO2 emissions
that occur in chemical manufacture as a direct result of combustion reactions.
Figure 22 displays that the largest portion of emissions from the production of 1 kg of
solvent is attributed to carbon dioxide. This large proportion of carbon dioxide is
attributed to the energy for raw material acquisition, production, and transportation of
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the solvent. Therefore, reducing the amount of fresh solvent required to run a process
can significantly reduce the carbon footprint of that process. It has also been
determined that there are specific anomalies in the pollution profiles of particular
solvents. IPA displays a significant amount of emissions to water as a result of
industrial production practices specific to that solvent. Similarly, the production of
THF displays a statistically larger CED than other solvents studied. THF also displays
a significantly larger associated waste, resulting from the increased energy
requirements. Thus, it may be concluded that the emissions from the manufacture of
organic solvents is unique only in the CED, although anomalies specific to production
of particular organic solvents do exist.

Table 13. CO2 and Energy Demands/Credits Associated with the Incineration of 1 kg
of Various Solvents.
CO2 Incin.
Acetone
Acetonitrile
Diethyl Ether
Ethanol
Hexane
IPA
MeOH
THF
Toluene

CO2 Offset CED Solvent. Prod. Total CED Offset

(kg CO2 ) (kg CO 2 -Eq)
2.55E+00
5.74E-01
3.31E+00
5.18E-01
1.47E+00
3.63E-01
1.40E+00
2.90E-01
1.17E+00
3.46E-01
2.00E+00
3.40E-01
9.40E-01
3.40E-01
8.36E+00
5.44E-01
2.43E+00
9.10E-01

(MJ-Eq)
6.73E+01
6.15E+01
4.80E+01
4.80E+01
6.17E+01
6.32E+01
3.76E+01
1.28E+02
6.34E+01

(MJ-Eq)
3.43E+01
3.27E+01
8.56E+00
1.69E+01
7.89E+00
2.68E+01
1.57E+01
9.08E+01
1.50E+01

The carbon and greenhouse gas (GHG) emissions associated with incinerating each of
these solvents also plays a crucial role in the life cycle emissions of these solvents.
Studies have shown that roughly half of the GHG emissions and 40% of the energy
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requirements of the life cycle of an API can be attributed to the incineration of solvent
waste. 11 In order to demonstrate the impact on pollution from the incineration of
solvent waste, two environmental metrics will be employed. These metrics are the
total carbon emissions directly released from the incineration of a solvent (CO 2
Incin.) and the CED resulting from solvent production (CED Solv. Prod.). Heat
energy, converted into steam and electricity, may be recovered from the incineration
process. Thus, an additional two metrics will be employed, the adjusted amount of
CO2 emissions released by the incineration of a solvent (CO 2 offset) and the adjusted
CED for the production of a solvent (Total CED offset). These two metrics take into
consideration the CO 2 released and the energy required with recovery of all energy
released during solvent incineration. These metrics are given in units of CO 2 -Eq and
MJ-Eq, respectively. These units represent the equivalent amount of CO 2 and the
equivalent amount of energy released and required, respectively. Table 13 displays
these metrics for the previously discussed solvents. Table 13 demonstrates that there
is a significant amount of CO 2 released and energy consumed during the incineration
of 1 kg of solvent, even when considering the use of steam generation for heating and
energy production to offset life cycle CO 2 emissions. This is most notable for the life
cycle of THF, displaying over double the CO 2 emissions and nearly double the energy
demand of other solvents.
This analysis shows that large quantities of emissions are released during manufacture
and incineration of organic solvents. Although commodity chemicals produce a
similar quantity and distribution of emissions during manufacture, in process
consumption of the chemical limits the quantity of the chemical that may be recycled.
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The mass intensity of solvents versus that of reagents within the pharmaceutical
industry also makes solvent recovery an environmentally valuable pathway. As
previously stated, solvents account for approximately 80% to 90% of the total mass
involved in a pharmaceutical production process. 12 It has also been determined that
there is a larger CED for organic solvents than there is for commodity chemicals.
Less widely used chemicals were also determined to produce a much larger amount of
emissions, as in the case of THF. This may be attributed to comparatively smaller
production quantities, as well as particularly problematic azeotropes in the case of
THF. Although many solvents display azeotropes, the azeotrope encountered when
separating THF and water is particularly energy intensive. It was also determined that
the majority of emissions are released to air, mostly as CO 2. Through solvent
recovery, the amount of required fresh solvent, solvent production emissions, and
incineration emissions may all be significantly reduced. This in turn will decrease the
environmental and economic burden of the process. 13
Because of wide scale use in the process industry, LCA will be applied to four
pharmaceutical case studies. These case studies will be used to demonstrate how
solvent recovery may reduce the environmental impact of a process as well as how the
use of LCA can clarify life cycle emissions for pharmaceutical solvent use. This may
in turn be employed to determine greener options for solvent use involving solvent
recovery or reduction.
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Chapter 3
Chapter 3: Case Studies of the Application of LCA in the Pharmaceutical Industry
Case Studies of the Application of LCA in the Pharmaceutical Industry
Portions of this chapter are taken directly from "LCA approach to the analysis of solvent
waste issues in the pharmaceutical industry" (Raymond, M.J., C.S. Slater, and M.J.
Savelski. "LCA approach to the analysis of solvent waste issues in the pharmaceutical
industry." International Journal of Green Chemistry. 12 (2010): 1826-1834) with the
permission of Sarah Ruthven and Gill Cockhead.3
Reproduced by permission of The Royal Society of Chemistry.
The article may be found online at the following location:
http://pubs.rsc.org/en/Content/ArticleLanding/2010/GC/c003666h
3.1. Description of Case Studies*
Three case studies were examined in which the use of solvents in the production of an
API was reduced by implementation of greener processes. Focus was directed
specifically to the implications of adding solvent recovery and reduction systems to
reduce the overall environmental footprint of the pharmaceutical process. A cradle-tograve approach was used to determine the amount of waste generated by solvent
production, in-process emissions, and disposal of process wastes. The first case study
considers the effects of recovering solvents within a pilot scale facility for the
production of a new oncology drug being developed by Bristol-Myers Squibb (BMS).
The second case study considers the effects of recovering solvents within a
commercial facility for the production of celecoxib, the active ingredient in Pfizer’s
*

Reproduced by permission of the Royal Society of Chemistry:
http://pubs.rsc.org/en/Content/ArticleLanding/2010/GC/c003666h
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Celebrex®, a non-steroidal anti-inflammatory drug (NSAID). 21 The third case study
considers the effects of recovering solvents within a process for the production of a
synthetic pharmaceutical intermediate. The final API is to be used for the treatment of
hypertension. The fourth case study considers the effects of recovering solvents from
the small volume lot production of a compound referred to here as Pfizer API "Z", the
active ingredient in a Pfizer drug. Due to confidentiality, details on this drug cannot
be disclosed. Following is a more detailed description of each case study. Details of
the design of the greener solvent recovery and/or reduction systems are not presented
in this paper and are available elsewhere. 22,23,24,25,26,27
3.1.1. Oncology Drug in Clinical Trials – Bristol-Myers Squibb*
The process examined by this case study is for the pilot scale production of an
oncology drug in clinical trials. During one step, a mixture of THF, water, and a
pharmaceutical intermediate must be dehydrated. As discussed previously, THF
displays an azeotrope with water at 95.7% water at standard temperature and pressure
(STP). In order to dehydrate the mixture, the current process employs a constant
volume distillation (CVD). CVD requires a large amount of an entrainer to be added
to the separation. The entrainer used in this process is THF, resulting in an increased
amount of THF waste. A proposal was made for the addition of a pervaporation (PV)
system to the current CVD. The PV system would dehydrate the THF to the desired
level and allow it to be recycled back into the process. The addition would decrease
the amount of entrainer required thereby reducing the amount of virgin THF
necessary and the amount of THF waste to be incinerated. 22,23,25,26
*
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3.1.2. Celecoxib – Pfizer*
The commercial scale production of celecoxib, the API in Pfizer’s arthritis drug
Celecoxib™, was studied to determine a green alternative for the handling of solvent
waste. During the final crystallization and production step, large quantities of IPA and
water are employed and constitute the majority of the waste stream. Separation of the
IPA and water mixture is complicated by a multitude of impurities in the waste
stream, including dissolved solids (or Total Dissolved Solids, TDS), methanol, and
ethanol. In addition, a variety of azeotropes arise between the IPA, methanol, ethanol,
and water. Currently, wastes are incinerated at an off-site disposal facility. Pfizer
suggested improving the process by employing existing capital assets. The goal of the
case study was to configure equipment already existing at the facility to recover and
recycle the IPA from the waste stream. An analysis on an array of designs
demonstrated that it was necessary to employ distillation and PV to produce IPA at a
high enough purity to be recycled. Based upon production flow rates and the available
equipment sizes, a distillation-PV-distillation system was deemed necessary to
achieve the required 99% pure IPA. Although several of the waste streams could be
treated by the PV system, one waste stream containing IPA and the highest
concentration of TDS was distilled once to concentrate the stream and then sold as a
“generic solvent” to a third party. The remaining IPA waste mixture was sent to the
distillation-PV-distillation system. This would allow an in-line recycle of the IPA at
the celecoxib production facility. This recycle of IPA and sale of the “generic
solvent” would reduce the total amount of virgin solvents required at the celecoxib

68

production facility and at the third party facility. In addition, the need to incinerate
solvent waste from the crystallization and production step would be eliminated. 22,23,24
3.1.3. Synthetic Intermediate – Novartis*
During the commercial production of a synthetic pharmaceutical intermediate, the
crude reaction mixture is produced in a Heck coupling reaction. This mixture contains
a significant concentration of Pd. This concentration must be reduced before the
intermediate may undergo further isolation. In order to achieve this, the current
process employs a batch adsorption with activated carbon as the main adsorbent.
Previous research indicated that an adsorbent which is more suitable for fixed bed
operation would decrease process wastes. In addition, the vessel must be thoroughly
rinsed with organic solvents and aqueous detergent after each adsorption. This
produces a large mass of solvent waste, containing mostly MeOH, and solid waste,
activated carbon. These wastes must be treated by incineration and disposal,
respectively, increasing the environmental footprint of the process. A proposal was
made to replace the batch adsorption with a fixed bed adsorber (FBA), in which a
synthetic resin would be used as the adsorbent. This would allow for a reduction in
the mass of virgin solvent and adsorbent required as well as a reduction in the
emissions from disposing of the associated wastes. 27
3.1.4. Pfizer API "Z" – Pfizer
This case study examines the recovery of solvent waste from small scale production
campaigns at a Pfizer facility. A series of potential solvent waste streams were
examined and compared for the potential environmental impact of solvent recovery.
*
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The main stream targeted for solvent recovery was a waste stream from the
production of Pfizer API "Z", the API in a Pfizer drug. The recovery process was
limited to distillation designed to recover 98% pure solvent for reuse.
3.2. Analysis of Case Studies*
The four case studies were analyzed and compared using a cradle-to-grave life cycle
analysis. For each case study, the current in-place process was considered the “base
case” for that study. Environmental impacts were calculated considering only the
differences between the base case and greener process design alternative in each case
study, therefore, emissions from the manufacture of raw materials, unit processes,
waste disposal, and other factors which were not affected by the green improvements
were not included in the results. Results were calculated in terms of kg of waste per
kg of API produced (kg of waste per kg of intermediate produced in the Novartis case
study). This was done to simplify the comparison of the processes, as total production
amounts varied from pilot to production scale. The total emissions and the
distribution of their origins for the four base case scenarios and the four green
alternatives are displayed in Figure 23 and Figure 24, respectively. These emissions
take into account emissions avoided by selling waste as a generic solvent and from
steam and electricity generation during incineration. These values were used to offset
the emissions from incineration and disposal of solvent and solid wastes. 22,23,24,25,26,27
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The energy used to operate the solvent recovery and reduction systems was analyzed
and the resultant life cycle emissions for its generation were determined. The
difference in emissions for the energy of the processes is listed as an emissions source
in Figure 23 and Figure 24 and includes the difference in energy requirements for
steam and electricity within the API/intermediate production processes with
incorporation of the solvent recovery or reduction system. Figure 23 and Figure 24
display the effect of solvent use on emissions within the pharmaceutical
manufacturing processes. Emissions are associated with heating, pumping, and
recovering solvents and entrainers used in the process. In some instances, the
implementation of a solvent recovery system will not affect other process emissions.
However, it may actually reduce emissions within the manufacturing process as there
is less solvent to be heated and pumped. As stated, all values are calculated
comparing the greener alternative process with the base case. For this reason, the
Pfizer Celcoxib and Pfizer API "Z" base case scenarios display no emissions from the
energy of the process as there was no change in the Celecoxib or Pfizer API "Z"
process, only in adding the solvent recovery system, which is shown in Figure
24.22,23,24 For the BMS case study, the allocation of wastes from the energy of the
process was altered significantly. The heat duty required to run the CVD was
decreased with the addition of the PV system, reducing the amount of steam required.
This was because the need to add and heat an entrainer was avoided. However, the PV
system has an associated electrical requirement so there is an increase in the
emissions from electricity usage. In essence, the PV system reduces the amount of
steam required for the CVD but increases the total amount of electricity
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required. 22,23,25,26 Similar differences are observed in the energy of the process for the
Novartis case study, resulting from allocation of process electricity. The replacement
of batch adsorption with an FBA system actually decreases the amount of energy
required as less adsorbent may be used and fewer vessel rinses are required. This
difference in energy, however, is insignificant as it represents only 1.34% of the total
life cycle emission reduction for the Novartis case study. 27
Pollution credits are given to the Pfizer Celecoxib proposal for sale of the mother
liquor waste. This is displayed as a negative value in Figure 24 and is used to offset
the total pollution attributed with the Pfizer Celecoxib case study. 22,23,24
For these case studies, it is apparent that the reduction in emissions due to solvent
manufacture is the most significant source of emission reductions, as can be seen in
Figure 23 and Figure 24. It represents 69% of the emission reductions for the BMS
case study - 49.4 kg of waste per kg of API produced, 62% of the emission reductions
for the Novartis case study - 6.38 kg of waste per kg API, and 54% of the emissions
reductions for the Pfizer API "Z" case study - 39.2 kg of waste per kg API. Excluding
the emissions avoided by sale of IPA, solvent recovery accounts for 37% of the
emission reductions, 6.58 kg of waste per kg API for the Pfizer Celecoxib case
study. 22,23,24,25,26,27
When these emission reductions are coupled with the reduction in emissions due to
avoidance of excess solvent waste that must be incinerated, the effect is
comparatively more significant. Figure 23 and Figure 24 demonstrate that a
considerable proportion of the life cycle emissions for an API are attributed to solvent
manufacture and incineration. This accounts for 88%, 75%, and 97% of the emission
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reductions in the BMS, Pfizer Celecoxib, and Novartis case studies, respectively. This
is attributed to the large amount of emissions resulting from solvent manufacture and
incineration, as opposed to the energy of the process. This accounts for 100% of the
emissions reductions in the Pfizer API "Z" case study, as the only source of
reductions is through solvent recovery and incineration. These proportions are
displayed in Figure 25.22,23,24,25,26,27

Solvent Manufacture
Process Energy
Incineration

BMS

Celecoxib

Novartis

Pfizer API "Z"

Figure 25. Proportion of Wastes Attributed to Solvent Manufacture, Process Energy, and
Waste Incineration for Each Base Case Scenario.

By implementing a solvent recovery or reduction system, over 90% of life cycle
emissions from solvent use may be avoided. When considered with the mass intensity
of solvents within the pharmaceutical industry, as discussed previously, this is a
significant reduction in overall process emissions for the production of an API.
Generally, greater than 80% of the raw materials that are employed in the production
of an API are solvents. If 90% of the associated emissions may be avoided, an overall
reduction of over 70% of the total emissions for the production of an API may be
expected.
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The overall reduction in emissions for each case study may best be displayed by a
direct comparison of each base case with the associated greener process case. This
comparison is displayed in Figure 26, Figure 27, Figure 28, and Figure
29.22,23,24,25,26,27
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Figure 26. Comparison of the Base Case and Green Process for the BMS Case Study.
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Figure 26, Figure 27, Figure 28, and Figure 29 display that there is a large reduction
in emissions with the addition of a solvent recovery or reduction system. The BMS
case study displays a 94% reduction in overall emissions, equating to a reduction of
64.3 kg of waste per kg of API. Similarly, there is a 91% reduction in overall
emissions for both the Pfizer celecoxib and Novartis case studies. This equates to a
24.1 and 10.34 kg of waste per kg of API reduction for the Pfizer and Novartis case
studies, respectively. 22,23,24,25,26,27 The Pfizer API "Z" case study displays a 76%
reduction in overall emissions, equating to a reduction of 73.11 kg of waste per kg of
API.
As it can be seen, the majority of the total emissions are attributed to processes
outside of the battery limits of a pharmaceutical production facility. Solvent
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manufacture and disposal account for the majority of emissions in all four base case
scenarios. If one were to view the environmental implications of solvent recovery
within the gate-to-gate perspective, restricting emissions to those within the battery
limits of the pharmaceutical manufacturing facility, there is little environmental
incentive to implementing a solvent recovery system. However, when the entire life
cycle analysis is taken into account, the environmental implications become much
more significant.
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Chapter 4
Chapter 4: Conclusions
Conclusions
Portions of this chapter are taken directly from "LCA approach to the analysis of solvent
waste issues in the pharmaceutical industry" (Raymond, M.J., C.S. Slater, and M.J.
Savelski. "LCA approach to the analysis of solvent waste issues in the pharmaceutical
industry." International Journal of Green Chemistry. 12 (2010): 1826-1834) with the
permission of Sarah Ruthven and Gill Cockhead. 3
Reproduced by permission of The Royal Society of Chemistry.
The article may be found online at the following location:
http://pubs.rsc.org/en/Content/ArticleLanding/2010/GC/c003666h

The TRI is a powerful tool for reducing the emissions for pharmaceutical facilities. The
TRI displays that the pharmaceutical industry has reduced its total emissions from 235
MM kg in 2001 to 85 MM kg in 2008. A closer look at the TRI displays that during this
eight year period, the same four chemicals - methanol, toluene, dichloromethane and
acetonitrile - have consistently ranked the top four most common pharmaceutical
solvents. It also displays that specific solvents attribute a proportionately much larger
amount of emissions per kg of solvent. By targeting these common solvents and
environmentally unfriendly solvents specifically, one may expect to maximize the
emissions reductions within a pharmaceutical production facility. The effect of targeting
a pharmaceutical facility was modeled and demonstrates this fact. By applying three of
the most common green engineering practices to a pharmaceutical production facility,
one may expect a 78% decrease in the overall emissions of the facility. By properly
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employing the information available in the TRI, green engineering practices may be
applied more precisely, targeting the largest environmental issues at hand, thus resulting
in a maximal reduction in facility emissions.
In 2008, the Toxic Release Inventory cited that the United States pharmaceutical
industry generated 88 million kg of waste (categorized by the US EPA as either
priority pollutants or hazardous air pollutants). 83% of this waste was attributed to the
top ten solvents in use in the pharmaceutical sector.4 By implementing an on-site
solvent recovery system, this waste may be significantly decreased. A multitude of
separation processes may be used to these ends, including traditional distillation and
more novel approaches such as pervaporation and nanofiltration, along with shifting
towards a continuous rather than batch process. 12
Through the use of Life Cycle Assessment in a series of case studies, it has been
shown that solvent recovery in the pharmaceutical industry has a significant and
universal effect on the environmental impact of API manufacture. First, the necessity
of performing an LCA on pharmaceutical solvent use was demonstrated by displaying
the large quantity of emissions produced outside of the battery limits of a
pharmaceutical plant due to solvent production and waste treatment.
Three aspects of solvent recovery and reduction are made apparent by these case
studies. The first is that solvent manufacture and incineration play a significant role in
the life cycle emissions of a pharmaceutical API. By implementing a solvent recovery
or reduction system, these emissions can be considerably decreased. The second is
that the energy of the process and the associated emissions are trivial compared to the
emissions due to manufacture and incineration of solvents. From this it is apparent
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that the increased energy and associated emissions resulting from the addition of a
solvent recovery or reduction system are minor in comparison to the emission
reductions resulting from the reduced amount of virgin solvent and solvent waste. In
some instances, the addition of a solvent recovery system may actually decrease
overall energy requirements of a process, as seen in the BMS case study. The final
and most significant aspect of solvent recovery and reduction is that the resultant
process emission reductions become apparent only when viewing the process from the
perspective of the entire life cycle. The gate-to-gate approach associated with the
emissions within an API manufacturing facility overlooks the global implications of
solvent recovery and reduction. When a life cycle analysis at a cradle-to-grave
perspective is considered, these emission reductions become evident. From such an
analysis, one may make a more complete decision on the greenest process for the
manufacture of an API.
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